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Program Description
WWPlus is a program that provides various tools to manage Windows Wallpaper.    It is a wallpaper 
changer, editor, and file converter.    The program includes a Screen Saver module that turns your 
wallpaper files into screen-covering images for entertainment, security, and to avoid image burn-in.

Users gain substantial disk space by using compressed image formats not normally usable as Windows 
wallpaper.    WWPlus includes tools that will convert images to and from these additional formats.

Editing features include: Crop, Rotate, Re-size, Stretch, and alteration of Brightness and Contrast.

Individual wallpapers may be positioned on the screen, and the program will "remember" their positions 
for future display.

WWPlus has a provision for reducing the colors in a 256-color image to 16 for VGA display, and for 
reducing True-Color (16 million colors) images to 256 (or 16) colors.

A Thumbnail function will display a small copy of all the wallpapers in a queue for easy selection.

Multiple "queues" (configuration files) may be maintained, each saved under a distinctive name.



Reduce colors to 16
Reduce colors to 256
These menu options are enabled when there are more than 16 colors or more than 256 colors, 
respectively, in the image displayed in the Picture Editor.    When an option is selected, WWPlus will 
"dither" the image to 16 or 256 colors



Caption Bar
The Picture Editor's caption bar will display information about the displayed image.    The format is NAME 
WIDTHxHEIGHTxCOLOR DEPTH.    During crop selection routines, the caption will show "crop" with the 
size of the selected area.
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Thumbnail Display
Small images of each of the bitmaps in your Wallpaper Queue are shown when you select the "View 
image thumbnails" option on the Images menu.    Depending on your computer speed and the number of 
images, it may take quite a while to load all of the images.    After loading once, subsequent displays will 
be much faster.    You may stop the load at any time by pressing the "Stop Loading" menu option (only 
visible while the images are loading), and then resume the load by pressing "Resume Loading" (only 
visible when the load has stopped short of completion).    Another option available during loading is 
"Cancel Load" which will erase the preview screen.

Once the images are loaded, you can move an image to the Picture Editor by double-clicking the image.   
If you want to know the file name and path for a displayed image, press the mouse button down while the 
mouse cursor is over the image.    The window caption will change to display the file name.    When you 
select an image by clicking on it the border of that image will turn red.    You may then edit or delete the 
image with the appropriate File menu command.

Using the thumbnail for manual wallpaper changes:    While the thumbnail display is on screen, the 
timer is disabled and the main program window is hidden.    You can minimize the thumbnail display and 
then use it to select wallpapers.    double-click the thumbnail icon to restore the display, click once on your
selection and then either use the file menu to Make Current Wallpaper, or use the keyboard shortcut 
(CTRL-M).

The thumbnail file will slow some operations down, particularly wallpaper deletions.    If you are deleting 
several files in a row it is best to choose the "Clear thumbnail file" option from the images menu, perform 
your deletions, and then let the thumbnail file rebuild the next time you use it.

It is possible for the thumbnail display to get "out of synch" with the wallpaper queue.    If that happens, 
clear it and rebuild it.



Speed vs. File Size
There is a tradeoff between program speed and the amount of compression used on images.    This is 
particularly noticeable when using the Thumbnail option.    Uncompressed .BMP files will display far more 
rapidly than the most compressed .GIF files, with .PCX between for both speed and compression.    .TIF 
and .TGA are normally used for pictures containing 32,000 or more colors; neither offers significant 
compression over .BMP, and both are slower.    For 24-bit (16-million color) images, WWPlus can use
.JPG format, which offers great compression, but is very slow and will cause some loss of image quality.

When the screen saver is active, moving the mouse or pressing a key will not restore your screen while 
an image change is in progress.    If you are using large compressed images (particularly .JPG) there may
be a significant delay before you can get your screen back again.

For more information about the pros and cons of the file types, see the text file FORMATS.TXT included 
with WWPlus.



Display Order
The Display Order option in the Preferences submenu of the Wallpaper menu or on the toolbar allows you
to choose Random or Sequential display.    Random display will cycle through the list of wallpapers in no 
apparent order.    Sequential will display them in the order in which they are listed in the Wallpaper Queue.
When changing from random to sequential, the display will continue from the currently displayed 
wallpaper.    Sequential order is good for slide show effects.



Up and Down Buttons
Use these buttons to organize the files in a queue in a desired order (for sequential display, or simply to 
manage the files better).    The buttons will only be visible when a file has been selected in the queue.    If 
the first file in a queue is selected, the Up button will not be visible, and if the last file in a queue is 
selected the Down button will not be visible.



List Full File Path/List File Name Only
This button controls the entries in the queue.    File Name Only will remove drive and path information, 
while Full File Path will include all directory/subdirectory information for each file.    In the latter case, the 
file name may be scrolled off to the right of the queue, making the entries difficult to read.    In any case, 
the listing for the current wallpaper will include full path information.



Monitor Com Port
Selected from the Preferences submenu of the Wallpaper menu, this option allows you to select a 
particular com port to monitor.    If WWPlus detects that another application has opened this port, it will not
allow the timer to cycle (which otherwise might interrupt serial communications).    This option is intended 
to be used only with a port that has a modem attached.    It will probably not work with other devices such 
as serial printers.    If an application normally keeps a port open, such as a Fax/Modem application, then 
wallpaper changes will never occur.



Add Button
The "Add" Button is used to add a new wallpaper to the Wallpaper Queue.    Pressing this button is the 
same as choosing "Add Wallpaper" from the Wallpaper menu; the keyboard shortcut is CTRL-A.    
Pressing this button will cause a dialog box to appear for browsing through drives and directories looking 
for bitmap files which can be selected for addition to the queue.    Files can have .BMP, .RLE,.GIF, .PCX,
.TIF, .ICO, .TGA, or .JPG extensions.    You may use the tiling option buttons to turn tiling on or off for the 
added files - the default will be the condition of the the Tiling on/off Option at the time the Add Button was 
pressed.    You may change the tiling for an individual wallpaper later, by first clicking on the filename in 
the Wallpaper Queue and then changing the Tiling on/off Option. The image will be positioned according 
to the setting of the default origin point.

Multiple file selection is allowed.    If the files are not contiguous in the directory, hold down the CTRL key 
while clicking each file.    Maximum number of files at one time is approximately 200.

You may add an image to the queue more than once to increase its display frequency.



Preview
Preview will give an "advance look" at a wallpaper before choosing it for editing, deletion, or making it the 
current wallpaper.    A wallpaper must be selected in the queue for this function to be active.    Command a
preview by clicking the preview button or double-clicking the gray preview display area.



Changing Queues
WWPlus allows multiple configuration file called "queues."    A queue file a list of the wallpaper files for that
queue.    Wallpaper files may appear in many different queues.    When a queue is loaded, its name will 
appear above the Wallpaper Queue listing.

The "Queues" selection in the Wallpaper menu has four options: "Start New Queue," "Change Queues," 
Clear Queue, and "Save Queue As."



Delete Button
The "Delete" Button will be disabled (grayed) unless an entry has been selected in the Wallpaper Queue.  
Pressing this button is the same as choosing "Delete Wallpaper" from the Wallpaper menu; the keyboard 
shortcut is CTRL-D.    If a selection has been made, it will be deleted. 

The program will offer two choices: delete from queue only or from the queue and your hard drive.    The 
latter will delete the file itself.    This will not affect the current visibility of the image if it is showing on the 
desktop.    If the wallpaper is listed more than once, only the selected occurrence will be deleted.    In that 
case, if the file was deleted, an error message will occur when the program attempts to display the image.



Change Wallpaper Button
The "Change Wallpaper" Button functions differently depending on whether an image has been selected 
in the Wallpaper Queue.    Pressing this button when an image is selected is the same as choosing "Make
Current" from the Wallpaper menu (keyboard shortcut: CTRL-M), which makes the selection the current 
wallpaper and displays on the desktop immediately.    The timer will reset automatically.

When there is no image selected in the queue, this button will cause a change of wallpaper exactly as if 
the timer had cycled.    The next image will be either randomly or sequentially selected depending on the 
setting of the Display Order option in the preferences menu.



Erase Button
The "Erase" button will clear any wallpaper showing from the screen.    Pressing this button is the same as
choosing "Clear Screen" from the Wallpaper menu; the keyboard shortcut is CTRL-C.    Close the program
or turn the timer off to keep a wallpaper from being displayed when the timer cycles.



Wallpaper Queue
The "Wallpaper Queue" is a list of bitmaps that are available for use by WWPlus as wallpapers.    You can 
show all of the images in the queue in "Thumbnail" form by choosing View Image Thumbnails from the 
Images menu.    You can add any appropriate bitmap image to the list via the Add Button or Import Button.
You can make a specific image occur more often by adding it to the queue more than once.    You may 
also add images to the queue by means of Drag and Drop from the File Manager.

You may have multiple queue lists; see Changing Queues 

For any of the following actions, you must first select a wallpaper in the queue.    This means that you 
must click once on a file name, then perform the action.

Delete Button.    
Preview
Tiling on/off 
Position Wallpaper 

The Change Wallpaper Button.    is a special case where the function will change depending on whether a
selection is current in the queue.



Change Delay
The box to the right of the caption "Minutes delay between changes" may be directly edited.    Allowable 
times are 0.1 to 999.9 minutes.    A delay of 5-30 minutes is suggested - there is a noticeable jump-delay 
on the screen when the wallpaper is changed, and this can be annoying if the timer cycles too frequently.  
On the other hand, when the computer is not being used, a short time interval may be used to produce a 
"Slide-Show" effect.

This setting will have no effect if the Timer switch is off.

Changing the delay time will cause the timer to reset (if it is on) and the "Minutes to next change" will 
become the new setting.



Timer on/off
The "Timer on off" icon determines whether the wallpaper will change at the interval set in the "Minutes 
delay between changes" box.    The icon will retain its setting between sessions of the program.    You may
wish to turn the timer off if you are working on a project where you would be annoyed by the screen 
"flicker" that occurs during a wallpaper change; you can accomplish much the same thing by simply 
maximizing the program with which you are working.    Turning the timer off and then on again will reset 
the timer, and the "Minutes to next change" field will revert to the timer interval.



Minutes to next change
This field will display the time, in tenths of a minute, until the next scheduled wallpaper change.    The field
is blank when the timer is turned off.    Countdown is suspended when the active application occupies the 
full screen (Maximized), which generally includes screensaver activity.



Tiling on/off Option
Wallpapers may be displayed either Tiled or not.    The Tiling Off option means that the wallpaper will be 
shown once at the origin point (see Adjusting wallpaper placement on screen).    With Tiling on, wallpaper 
that is smaller than the screen size will be shown in multiple images to fill the entire screen.    The position
of this switch when a new wallpaper is added to the queue will determine the initial setting for that 
wallpaper.    To change a wallpaper's setting, select it in the queue and then change the switch.



Registration

Don Bradner
Arcata Pet
600 F Street
Arcata,CA 95521-6301
WWPlus copyright 1992-1995 by Don Bradner.    WWPlus is Shareware.    Click here to print a 
Registration Form and send it with $15.00 to the author at the above address.    California residents 
please add $1.09 for state sales tax, and Non-US users please add $1.00 for Air Mail service. See Author 
Support for information on contacting the author

Compuserve members may register on-line for $20.00 (higher price reflects costs imposed by CIS), 
includes any applicable tax or foreign shipping.    To use this method, GO SWREG.    The program 
registration number is 2213.    Regardless of the method of registration, you will receive a copy of the 
most recent version of WWPlus and a registration key that will eliminate the startup screen for this and all 
future versions of WWPlus.    Some high-resolution photographic images in .GIF format will also be 
included..

Commercial use:    WWPlus may be used commercially, as long as there is a registered copy for each 
computer/terminal that is using it.    The author is willing to discuss customization of the program for 
commercial/large scale application, including use as presentation software.



Author Support
The author is very interested in providing support for this program.    Feel free to contact him in any of the 
following ways:

Mail:
Don Bradner
Arcata Pet
600 F Street
Arcata, CA 95521-6301

FAX: (707) 822-6570
Phone: (707) 822-6350 10am-5pm Pacific Time, ask for Don

Compuserve: 76130,1007
AOL: DBirdMan
Internet: dbirdman@aol.com



Current Wallpaper
The Current Wallpaper area at the bottom of the WWPlus screen displays the complete path for the 
currently displayed bitmap.    If there is no wallpaper displayed, the listing will be "(None)"



Edit Image
Pressing this button is the same as choosing "Edit Image" from the Image menu; the keyboard shortcut is 
CTRL-E.    If you have previously selected an entry in the Wallpaper Queue, clicking this button will open 
the Picture Editor with the selected entry displayed, ready to edit.    Otherwise the editor will open with the 
file load dialog to load an image.    Use the latter technique to edit an image that is not in your current 
queue.



Picture Editor
The Picture Editor is a major feature of WWPlus.    You can access the Picture Editor by selecting a file in 
the Wallpaper Queue. and pressing the Edit Button.    You can also access the Editor from the Thumbnail 
Display by double clicking on a displayed image.    When the image is displayed, you may edit it in a 
variety of ways.    Choose an option below to learn more about the use of editing features.

Caption information

Edit Options:
Resize
Re-size to 640x480
Re-size to 800x600
Re-size to 1024x768
Stretch
Crop
Rotate
Mirror
Brightness & Contrast
Reduce colors to 16
Reduce colors to 256
Copy
Paste

File Options:
New
Save
SaveAs
Add to Wallpaper Queue



Add to Wallpaper Queue
Add to Wallpaper Queue in the File Menu will add a listing for the current image in the Picture Editor.    
to the WallpaperQueue.    You will only be able to add images in these image types: .BMP,.RLE, .GIF,
.PCX, .TIF, .TGA, .ICO, and .JPG.

You may add an image more than once to increase its display frequency.



Copy
The copy option in the Picture Editor's Edit menu will copy a displayed image to the Windows Clipboard, 
where it can be pasted into other applications.



Paste
The Paste option in the Picture Editors Edit menu will only be active (not grayed) when the Windows 
Clipboard contains an image that can be read by this program.    The pasted image will replace any image
already displayed; a prompt will be issued to save the current image if it has been altered.



Load File dialog box
The Load file dialog is shown when the Add button or Import button is clicked, as well as from the New 
menu option in the picture editor.    You may browse through your directories to find any image file which 
WWPlus recognizes.    A handy preview function is included.    Select a file and click the Preview button.    
A small "thumbnail" version of the file will appear in the box above the button.    When you have found an 
image that you wish to load, click OK.    To exit the dialog without making a selection, click Cancel.

Multiple file selection is allowed.    If the desired files are not contiguous, hold down the CTRL key and 
click each file.    Maximum number of files possible is approximately 200; if more are selected, only the 
last one will be added.    If multiple files are selected and the preview option is used it will show the last file
selected.    Multiple file selection is not available if the Add function originated from the thumbnail view or 
the Picture Editor.



Save As dialog box
The Save As dialog is shown when a file is Imported, when Save As is chosen in the picture editor, and 
when Save is chosen in the picture editor but the file is not of a type that can be saved by WWPlus.    You 
may use the dialog to change the name and/or the file extension.    Note that the file extension is 
governed by the option selection at the lower right of the screen.    If you name a file "MYFILE.BMP" and 
select .GIF as the extension, the file will be saved as "MYFILE.GIF" and the type will be .GIF.    When you 
choose a file type, you may check the "Make Default" checkbox for that extension.    If you change 
directories, the new directory will be the one showing the next time you use the dialog.    The .RLE 
and .ICO filetypes that are supported for loading a file are not supported for saving.



Resize
This menu option will allow you to re-size an image in the Picture Editor.    You will see a dialog box with 
various options.    If you want to re-size an image to 80% of its original size, input 0.8 in the Scale box.    
To re-size 125%, enter 1.25.    You may enter a new width and/or height directly - if the Proportional Re-
size checkbox is checked, the other dimension will also change to keep the same proportions.    
Otherwise, the image will stretch to accommodate the new width or height.

The Preview button allows you to see the effect of your selection without changing the underlying image.   
The OK button will alter the image to match the new settings.    Cancel restores the unaltered image.



Resize to 640x480
Operates the same as Resize except that the dimensions are fixed for a VGA screen.    This function 
always produces an image proportional to the original, which means that if the ratio of the original's width-
to-height is less than 1.33 the produced width will be less than 640, and if the ratio is greater than 1.33 
the produced height will be less than 480.



Resize to 800x600
Operates the same as Resize except that the dimensions are fixed for an SVGA screen.    This function 
always produces an image proportional to the original, which means that if the ratio of the original's width-
to-height is less than 1.33 the produced width will be less than 800, and if the ratio is greater than 1.33 
the produced height will be less than 600.



Resize to 1024x768
Operates the same as Resize except that the dimensions are fixed for a 1024x768 (8514-type) screen.    
This function always produces an image proportional to the original, which means that if the ratio of the 
original's width-to-height is less than 1.33 the produced width will be less than 1024, and if the ratio is 
greater than 1.33 the produced height will be less than 768.



Stretch
Stretch is also called "Free Re-size."    When this option is selected, the mouse cursor will change to a 
four-arrow configuration.    You can then "grab" any side or corner of an image and drag it to a new size.    
When you release the mouse button, the image will be stretched or compressed to fit the new window 
size.    When you have finished re-sizing, select the Edit menu again and re-select Stretch to accept the 
changes or select Undo Stretch to discard your changes.

For re-sizing to specific dimensions, use the Resize option in the Edit Menu.



Crop
Crop allows you to select an area of an image displayed in the Picture Editor.    Make your selection by 
moving the mouse cursor to a starting corner of the area desired.    Press and hold the mouse button 
down, "sweeping" over the selected area.    An outline box will display the chosen area, and the Picture 
Editor top caption bar will display the size of the area chosen (in pixels).    When the cropping selection is 
completed, release the mouse button.    If a different selection is desired, repeat the above steps; the first 
selection will be erased as the new selection is begun.

If the region you have selected is not quite right, you may choose to adjust the selected area.    See 
Adjusting Crop Boudaries

When you have a selection that you wish to use, select Crop from the Edit Menu.    The window frame 
will shrink to match your selection.



Adjusting Crop Boundaries
Whenever there is an active cropping region, there will be an active entry in the Edit menu of the Picture 
Editor for "adjusting crop boundaries."    Selecting this option will show a form to enter new offsets for left, 
right, top, and bottom borders of the cropping region.    You may directly enter new numbers, and the 
"rubber band" area in the editor will dynamically change to reflect the new settings.    Choose OK to 
accept the changes or Cancel to restore the original cropping region.



Rotate
The Rotation submenu has options to rotate an image in 90 degree increments left or right (counter-
clockwise or clockwise) as well as 180 degrees.    Rotating 180 degrees is not the same as Mirror 
Vertical, which changes the orientation of the image.    Rotating 90 degrees 4 times in the same direction 
will restore the original image.



Mirror
There are two mirror choices in the Edit Menu.    Mirror Horizontal will flip the image displayed in the 
Picture Editor left-to-right.    Mirror Vertical will flip the image top-to-bottom.



Brightness & Contrast
The Brightness & Contrast controls allow some alteration of these characteristics of an image displayed
in the Picture Editor.    When this option is selected from the Edit Menu, two slide bars will appear at the 
bottom of the editor as well as Accept and Reject buttons.    Sliding the top control will affect the image's 
brightness, while the second bar will affect contrast.    Using the two together will have various effects, 
which will be immediately visible when the mouse button is released.    When editing is completed to your 
satisfaction, press the Accept button, or if you feel that the original image is preferable, Reject the edited 
version in favor of the original.



New
New in the File Menu allows you to place a new image in the Picture Editor, replacing the existing image. 
You are not limited to the list of wallpapers in the Wallpaper Queue; any valid image may be loaded in any
format recognized by WWPlus:    .BMP, .RLE,.GIF, .PCX, .TIF, .TGA, .ICO, or .JPG.



Save
Save in the File Menu will save the image that is currently displayed in the Picture Editor,as long as the 
image is in a format which WWPlus can write:    .BMP,.GIF, .PCX, .TIF, TGA or .JPG. .RLE and .ICO, can 
be loaded but not saved.    If you try to save an image in a format which WWPlus cannot write, you will be 
prompted to use Save As instead.



Save As
Save As in the File Menu is used to change the name, directory, or file type of an image in the Picture 
Editor.    You will only be able to save in the wallpaper types, .BMP,.GIF, .PCX,, .TIF .TGA or .JPG.



Import Wallpaper
The "Import" selection in the Wallpaper menu is used to add a new wallpaper to the Wallpaper Queue and
change the format at the same time.    The keyboard shortcut is CTRL-I.    Pressing this button will cause a
dialog box to appear which will allow you to browse through your directories looking for bitmap files which 
you can select to add to the queue.    Files may have .BMP, .RLE,.GIF, .PCX, .TIF, .TGA, .ICO, or .JPG 
extensions.    Tiling works as described in the Add Button topic.    Another dialog box will prompt you for a 
filename and extension to save the file as, limited to the same extensions less .RLE and .ICO.



Wallpaper Menu
The Wallpaper menu duplicates the various buttons in the WWPlus interface, making it easy to use the 
functions from the keyboard, and has additional functions as well.    Using the Alt-W key combination will 
pop up the wallpaper menu, and then you may select an option by pressing the letter underlined in that 
option or using the arrow keys to move to the option.    Most options also have "hotkey" combinations that 
are shown to the right of the option.    For example, holding down the control key and pressing 'A' will have
the same result as selecting "Add Wallpaper."

Menu items include:

Add Wallpaper 
Import Wallpaper 
Make Change 
Delete Wallpaper 
Clear Screen 
Preview 
Position Wallpaper 

The wallpaper menu also includes a submenu to manipulate queues.



Preferences
This menu contains items that affect the way WWPlus works.    It allows you to change a number of 
defaults to customize the program to your own liking.    Click any of the topics below to get information on 
that topic.

Change Wallpaper at Startup
RemoveWallpaper at Exit
Special 'Multipurpose' Icon
Screen Saver Setup
Display Order
Set Default Origins
Smart Captions
Monitor Com Port



Change Wallpaper at Start
By default, WWPlus does not change your wallpaper when the program is started.    If you want it to do 
so, check this option.    If WWPlus is in your Program Manager Startup Group, you will get a new 
wallpaper whenever you start a Windows session.



Remove Wallpaper at Exit
When this option is enabled, WWPlus will clear any wallpaper when the program ends.    This can be 
useful if you normally have WWPlus running all of the time, and the only time it exits is when you exit 
Windows.    With this option, there will be no wallpaper when you next start Windows, resulting in a 
quicker load time.



Special 'Multipurpose' Icon
This option, found under the Preferences sub-menu of the Wallpaper menu, allows control of a number of 
the program functions without having to restore the main WWPlus screen.    Checking this option will 
replace the regular icon with a small multi-function icon as shown above.    NOTE: This option has no 
effect if you have chosen to hide the icon.

The icon panels correspond to the same icons in the main WWPlus toolbar.

The eraser portion of the icon will immediately clear the screen of any wallpaper.    The timer portion will 
toggle the timer on and off; it will be green when on and red when off.    The small monitor image turns the
Screen Saver off and on, and the change portion at the lower right will change the wallpaper and reset the
timer to its starting value.    Double-clicking the Control Box will restore the main WWPlus window.    The 
top bar can be used to drag the icon to a desired location, it will return to that location in the future.

There is an Always On Top option in the control menu that will make the Multipurpose icon float above 
other application windows.

Keyboard shortcuts:    When the icon is active (the top bar will have the color of an active window), you 
may use the following shortcuts:

CTRL+T will toggle the timer.    CTRL+C will clear the screen.    CTRL+S will start the screen saver.    The 
Spacebar will change the wallpaper.    ENTER will restore the main window.    ALT+F4 will end WWPlus.    
F1 will provide this help screen.



Set Default Origins
This item in the Preferences sub-menu sets the default location for each newly added wallpaper image.    
You may change the individual setting later - see Adjusting wallpaper placement on screen



Images Menu
The Images menu has four options: Edit Image will load the Picture Editor, either with a file selected from 
the queue or with a load dialog if no image was selected.    Batch File Conversion, as the name implies, 
allows you to convert the format of a number of files at one time.    View Image Thumbnails will load small 
sketches of each image for viewing/editing (see Thumbnail Display) and finally Clear Thumbnail File will 
erase the thumbnail file produced by the preceding command.    Clearing the thumbnail is often preferable
when several files are going to be deleted from the queue, since there will be long delays while the 
thumbnails are updated.



Help Menu
The Help Menu provides several options: Overview, which will display an image of the program where you
can click on an element to see its description; Contents, which displays the table of contents; Search for 
help on..., which allows the helpfile to be searched by key word; Author Contact & Support, which takes 
you to that topic, and About, which provides current version information for WWPlus.    The help icon 
(question mark) is the same thing as Help/Overview.



.BMP
Files with .BMP extensions are bitmapped images created by tools like Windows Paintbrush.    .BMP is 
the native format for Windows wallpaper.    There are a few .BMP files distributed with Windows 
specifically for use as wallpaper.



.GIF

.GIF, pronounced "Jiff" is a format developed by Compuserve Information Services.    It provides the most 
compression possible without loss of image quality.    It is the format of choice for images distributed 
through on-line services and BBS services, since it reduces the time necessary to transmit.    Storing your 
wallpapers as .GIF files will use the least amount of space, and WWPlus will take care of converting the 
format for Windows as required.    Because this conversion takes a small amount of time, it could result in 
an unacceptable delay on slower computers.



.PCX

.PCX is a format developed by the Z-Soft corporation for their line of PC Paintbrush programs.    Windows 
Paintbrush is also able to read and save this format.    It provides some compression when compared to
.BMP files, but not as much as a .GIF.    Like .GIF, .PCX can not be used as a native wallpaper format, but
WWPlus will take care of the translation.    There is less noticeable delay when using .PCX than with .GIF.



.TGA

.TGA is called "Targa."    It is primarily a format for storing 24-bit (true-color) 16-million color images.    
WWPlus can read the format, and use it as a wallpaper, but there is no space advantage and it will load 
slower than .BMP.    If you have a Targa image that you would like to use, Import it and save it in .BMP 
format (or convert it to .GIF if it has 256 colors or less).



.TIF

.TIF is the extension used with Tagged Information File Format (TIFF) files    It is primarily a format for 
storing 24-bit (true-color) 16-million color images and gray-scale images in desktop publishing.    WWPlus 
can read the format, and use it as a wallpaper, but there is no space advantage and it will load slower 
than .BMP.    If you have a Tiff image that you would like to use, Import it and save it in .BMP format (or 
convert it to .GIF if it has 256 colors or less).    Tiff files may contain more than one picture.    If that is the 
case, WWPlus will only read the first image.    An exception is the .TIF file used to store WWPlus's own 
Thumbnail files.



.JPG
Files with .JPG extensions are "JPEG" compressed.    JPEG stands for Joint Photographic Experts 
Committee.    This format is only suitable for 24-bit (16-million color) images, although WWPlus will allow 
you to save 256 color images in this format, and is "lossy," which means that the compression involves 
some loss of quality.    The resulting file size is quite small, but takes a long time to decompress and 
display.    When saving an image in the JPEG format you may select a quality factor from 5 to 95; the 
higher the number, the less compression and greater quality.    There is no particular speed advantage to 
any of the settings.



.RLE
Files with .RLE extensions are compressed bitmap images.    RLE stands for "Run-Length Encoded."    
RLE files may have an extension of .RLE or .BMP, however the .RLE extension avoids confusion as to 
whether the file is compressed.    Windows has no problem using .RLE files as wallpaper, but Windows 
Paintbrush will not load or create them, nor can WWPlus save a file in this format.    A third-party tool must
be used.



.ICO
Files with .ICO extensions are Windows icons.    You may use these 32x32 pixel 16-color images as 
wallpaper, presumably tiled to fill the entire screen.    WWPlus does not have the facilities to create or 
save .ICO files.



Wallpaper
Wallpaper is the term used to describe an image being displayed on the Windows desktop as a 
background.    It can be a small image that is repeated many times, or a single image of any size up to the
full screen size.



The Author



Bitmaps
A bitmap is an image stored as a pattern of dots.    These images can be stored in a number of graphics 
formats, but the only formats which can be used as wallpaper directly by Windows are .BMP and .RLE.    
With WWPlus, you may use .GIF, .PCX, .BMP, RLE, .ICO, .TIF, .TGA, and .JPG as wallpaper, and the 
program will interpret the files as necessary for use by Windows.

Where to get bitmaps
Several .BMP files are included with Windows for use as wallpaper.    Additionally, you can draw your own 
bitmaps with Windows Paintbrush.    If you have a scanner, you can scan images and store them as 
bitmaps.    Many computer stores and printing businesses offer custom scanning to order.    On-line 
services have thousands of files which can be used as wallpaper.    Most of these files will be in .GIF 
format, which cannot directly be used as wallpaper except with this program.

The author of WWPlus now offers a scanning service, with free scans when registering the program.      
See the file SCANNING.TXT in your WWPlus directory.



Files
Several files make up the complete WWPlus package.    A brief discussion of each follows:

Files included with WWPlus
In the distribution package, most of the following files will have their last letter replaced with an 
underscore (_).    This indicates that they are compressed files, which are expanded by the setup 
program.

WWPLUS.EXE This is the program file.    Default installation is to C:\WWPLUS, and it will be added to a 
WWPlus program group.    For normal operation it is recommended that the icon be added to your Startup
Group, so that it automatically runs whenever you run Windows.

WWPLUS.HLP The WWPlus help file which you are reading now.    Placed in you WWPLUS directory, 
with an icon in the WWPLUS program group.

IMK.DLL
JPEGIO.DLL
KNIFE.VBX
WWPLIBR.VBX
These are "custom-control" libraries that WWPlus uses for some of its functions.    These files must be in 
your Windows\System directory for proper operation of WWPlus.

WWPSAVR.SCR
WWPSAVER.EXE
These are the WWPlus Screen Saver modules.    WWPSAVR.SCR must be in your Windows directory, 
and WWPSAVER.EXE is in your WWPLUS directory.

SETUP.EXE
SETUP.LST
SETUPKIT.DLL
SETUPWWP.EXE
VER.DLL
These files are used by the Setup program, which installs WWPlus.

README.TXT A text file explaining the nature, installation, and operation of WWPlus.
HISTORY.TXT A text file that describes the changes made to WWPlus with each release.
FORMATS.TXT A text file explaining each of the graphics formats, with the pros and cons of using each.
SCANNING.TXT A text file explaining photo scanning services offered by the author.
These files are placed in your WWPLUS directory, and have icons added to the WWPLUS group.

FILE_ID.DIX A program description file for BBS operators.
VENDOR.DOC A program description file for shareware vendors.
These text files are included with WWPlus, but are not installed on your hard drive.

Registered users will have one additional file: WWP_REG.KEY.    This file must be in your WWPLUS 
directory, and will keep the startup shareware screen from appearing.    If you upgrade to a new version of
WWPlus, do not delete this file - it will work with all future versions.

Files maybe not included with WWPlus
VBRUN300.DLL A "runtime" library for programs written in Visual Basic 3.0.    This file is almost always 



available from any source for WWPlus.    From on-line sources, look for VBRUN3.ZIP or VBRUN300.ZIP.   

Files created by WWPlus
WWPLUS.BMP    This is a "temporary" file that WWPlus uses to translate non-standard images so that 
they can be used by Windows.    It is destroyed and recreated each time the wallpaper changes and the 
new image is not a .BMP file.    It is located in your WWPLUS directory.

*.QUE These are queue files used to store information about images in a queue.    They do not have to be
in any particular directory, but the default is your WWPLUS directory.

*.TIF files    These are multiple image files used to speed the display of thumbnail images.    There will be 
one for each queue in which you access the thumbnail option.    These files are maintained in your 
WWPLUS directory.

WWPlus also creates some other temporary files with .TMP extensions.    Under normal use, the program 
will clean these up when it exits.    If the program crashes, it will clean them up the next time it is run and 
then exited normally.



Distribution
WWPlus is shareware and may be freely distributed as long as all of the files are included and no fee is 
charged beyond a reasonable fee for distribution.    Registered users note:    Do not distribute your 
WWP_REG.KEY file.

All rights are reserved by the author (see Registration).



Troubleshooting
If your difficulties are related to slow operations with specific images, see Speed vs. File Size

Other difficulties running the program may be associated with a missing file, or a file that needs to be in 
the Windows or Windows\System directory but isn't.    See Files for details.    Another problem is a 
corrupted WWPLUS.INI file.    It is sometimes possible to fix a corrupted file; if you are an experienced 
Windows user and regularly alter .INI files, you may want to load WWPLUS.INI into Notepad and see if 
anything is obviously bad.    If you are not comfortable with this, or cannot determine the problem, rename 
the file (it is in your Windows directory) to WWPLUS.OLD and restart the program.    This will not delete 
any of your wallpapers, but you will have to re-add them to your Wallpaper Queue.    If the program now 
runs correctly, and you do not want to completely rebuild all of your settings, you can compare the 
contents of the newly created WWPLUS.INI with the old file and look for bad settings in the old file.    If 
you can correct them, you can rename the .OLD file back to .INI and go on from there.

There is a specific Windows problem that causes Windows to hang if a wallpaper with more than 256 
colors is loaded when a 256 color display is in use.    Waiting a long time (often several minutes) will 
usually result in a completed load.    WWPlus will not let you do this - it changes the file to 256 colors 
before displaying it.    However, if you are running a display at more than 256 colors (such as 32K, 64K or 
16 million colors), the wallpaper can have that many colors.    If you then change display drivers to 256 
colors, Windows will crash and not load.    If this happens, you have two options.    You can run setup from 
the DOS prompt within your Windows directory and change to a 16 color driver or a true color driver, and 
reload Windows.    Clear the wallpaper and then proceed to change to the 256 color driver.    Alternatively 
you may use the DOS Edit function to edit your WIN.INI file and delete the wallpaper file reference.    It is 
best to avoid this situation by always using the "Clear Screen" function before changing display drivers.



Using WWPlus to create presentation Slide Shows
WWPlus can be used to make continuously cycling slide shows by setting a short display interval and 
then minimizing your Program Manager and any other running programs.    Setting the Display Order to 
Sequential will display images in the order they are listed.    The thumbnail view can help you see the 
"slides" as they will be shown.    Using this feature in conjunction with the ability to setup different queues 
can make for interesting self-running displays.    See Changing Queues.

You can manually cycle a slide show by using the "Special 'Multipurpose' Icon" option in the Preferences 
sub-menu of the Wallpaper menu.



Adjusting wallpaper placement on screen
Changing the wallpaper's location
By default, there are only two ways to display a wallpaper in Windows: Tiled, or single/centered.    Tiled 
wallpapers are repeated as necessary to cover all of the screen background.    With tiling off, wallpapers 
are displayed just once on the screen, normally in the center.    If the Wallpaper is the same size as the 
screen, tiled and centered will look exactly the same.    You may change the location of a non-tiled 
wallpaper by setting the wallpaper origin (upper left corner position).

Setting the wallpaper origin

For all of the following, remember that a setting of 0 (zero) for X or Y coordinates will center a wallpaper 
on that axis.    You cannot set the upper left corner of a wallpaper to 0,0; use 1,1 instead.

First, select a default origin.    Click the Wallpaper menu on the main program screen, click Preferences, 
and then click Set Default Origins.    A dialog box will prompt you for settings and take care of the details.   
The next wallpaper change will incorporate the new settings unless a specific origin is set for that 
wallpaper.

To select a specific origin for a wallpaper, directly position the wallpaper, or change the settings. In either 
case, first select the file in the Wallpaper Queue. Choose Position Wallpaper in the Wallpaper menu.    
The program screen will be replaced by the image, which you may move by pressing and holding down 
your left mouse button.    When you have the image positioned where you want it, release the mouse 
button.    Double-click on the image or press the Enter key to "fix" the placement.    Press the escape key 
to exit without setting a new position.    Alternatively, you may enter the numbers directly in the X and Y 
coordinate boxes after selecting the file in the queue.    If either of the coordinates end up being zero, the 
box will read "centered" to remind you that it is not a true zero.



WWPlus Version 1.43
Registration Form

Thank you for registering
There are several registration methods available:
With a credit card you may order by FAX: (707) 822-6570

    or Phone: (707) 822-6350
By mail, with check, credit card, or money order in US Dollars to: Don Bradner

Arcata Pet
600 F Street
Arcata, CA 95521-6301

Compuserve members may register on-line:    GO SWREG, program registration number is 2213.    
Note that this costs US$20.00 (includes any sales tax or Air Mail costs).    This is a slightly higher 
price than by other methods, due to the added costs imposed by Compuserve.

Registration price is US$15.00, including postage within the US.

Number of registrations desired _____ x 15.00 = $____________
      California residents add $1.09/registration sales tax ____________
      Non-US add $1.00/registration for air mail         ____________

Total     ____________
Software will be sent on 1.44 meg 3-1/2 inch disk.    Send disk to:

Name:                                  ____________________________________________________

Mailing Address:            ____________________________________________________

City/State/Country:    ____________________________________________________

Phone number (______)______________________

If paying with a credit card: Card type    VISA        MasterCard      AMEX        Discover� � � �

Card Number:    ___________________________________ Expiration Date: ________

Signature to authorize charge: ________________________________________
(optional) Where did you get WWPlus?

BBS or other on-line service.    Which one?_____________________�
Software/Shareware Service.    Which one? ______________________�
Shareware CD-ROM.    Which one?__________________________�
Friend�
Other _________________________________________�

(optional) What do you like about WWPlus:

_______________________________________________________
(optional) What would you like added or changed in WWPlus:

_______________________________________________________



Hiding the program icon
While WWPlus is running an icon will normally be displayed at the bottom of your screen.    Once you 
have made all of the wallpaper selections that you desire, you may "turn off" the icon by selecting that 
option.    The icon on the program screen will change ('Xed'-out).    The program icon will not be visible, 
and the program will not show up in the Task Manager list.    If you need to change something in the 
program, go to your startup group (or whatever group the program is installed in) and double-click the 
icon.    This will not run a new copy of the program, rather the existing copy will become visible.



WWPlus Screen Saver
WWPlus is distributed with two modules that allow you to use your wallpaper images as a screen saver. 
Screen savers have several purposes.    Traditionally, they are used to prevent screen burn-in, which is a 
persistent image that shows even when the monitor is turned off.    Modern VGA and better screens do not
usually exhibit burn-in problems, but it may be comforting to have the screen not remain static anyway.    
Now the primary purpose for screen savers is entertainment and minimal screen security.

The WWPlus screen saver meets all of these purposes.    Cycling different wallpapers will avoid screen 
burn-in, provide entertainment, and provide security.    Security means that prying eyes will not see open 
windows on your screen, and can include optional password protection.

The screen saver uses a number of the configuration items from WWPlus, such as the display order, and 
has a number of other configuration items of its own.    Setup and configuration can be done from 
WWPlus via the Setup Screen Saver button and preference menu items or from the Windows Control 
Panel, Desktop icon.    Either method will give you access to the Screen Saver Configuration Dialog.

WWPlus must be running in order for the screen saver to work.    If WWPlus is not running, either when 
the screen saver is started either due to inactivity or in reponse to the test button in the Windows Control 
Panel, the screen saver will attempt to start WWPlus.    If it is unable to do so it will post an error message
and terminate.    If you move the location of the WWPlus program, it will normally register itself with the 
screen saver the first time you run it.

Turning the regular WWPlus timer off and using the screen saver option can remove the problem of 
wallpaper changes disrupting your regular computer work.    All changes will occur only during idle times.

Speed and performance issues affect the screen saver in the same manner as anything else involving 
graphics in the Windows environment.    If the system is in the middle of a complicated decompression of 
a large image when you move the mouse or press a key there will be no response until the new image is 
displayed.    You may have to re-move the mouse or press another key at that point.    If your images take 
a long time to decode you may find that a fairly long cycle time will minimize the likelihood that an image 
change is occurring when you want to go back to work.



Screen Saver off/on button
This button, which also occurs on the Special Multipurpose Icon, turns the screen saver off or on.    When 
the screen saver is off, the small monitor image will be red, and when the screen saver is on the image 
will be green.    Configure the screen saver by using the Setup Screen Saver button. For general screen 
saver information, see the WWPlus Screen Saver topic.



Setup Screen Saver
The Screen Saver Setup button gives you the opportunity to change screen saver options from WWPlus 
without having to use the Windows Control Panel.    There are options to change the inactivity delay and 
to configure or test the screen saver. For general screen saver information, see the WWPlus Screen 
Saver topic. 

Delay
This setting determines how long an inactivity period must be for the screen saver to automatically 
activate.    Allowable range is 1 minute to 99 minutes.    If a larger or smaller setting is made, WWPlus will 
adjust to the allowable minimum or maximum.    Inactivity means no mouse movement or keyboard 
presses.

Configure
This button will invoke the Screen Saver Configuration Dialog, from which you may make changes in the 
way the screen saver operates.

Test
Pressing the test button will immediately start the screen saver.

Hot Corners
Moving your mouse to a Hot Corner will immediately activate or disable the screen saver.    On the small 
representation of your screen, the immediate activation corner is shown as a plus (+) sign, and the 
disable corner is shown as a minus (-) sign.    To use a different corner, click in a blank corner and 
respond appropriately to the dialog.    For hot corners to function, you must have the WWPlus screen 
saver turned on.



Queue Title
The Queue Title is the file name for the queue currently in use.    See Changing Queues for general 
information on this topic.



Screen Saver Configuration Dialog
The Screen Saver Configuration dialog is accessed from the Setup Screen Saver button on the WWPlus 
screen or from the Windows Control Panel. 

Entry Options:
Timer    - Turn the image-change timer on/off and set the time between image changes.    Range of values
is 10-6000 seconds.
Background color - Choose your regular desktop color or black.
Image Position - Choose center, or use whatever position is set in WWPlus for that wallpaper.
Monitor Port - If you select a Com Port, the WWPlus Screen Saver will check to see if that port is open 
before changing images.    If it is, no activity will occur.    An application that keeps the port open, such as a
Fax/Modem application, will suspend changes indefinitely.    This is a shared option with WWPlus.    
Changes made in WWPlus or here will affect the other application.
Dont Start - Available only with a monitored port, Dont Start means that the screen saver will check the 
port before activating and abort if the port is open.    If this box is not checked, the startup will occur 
regardless of port activity.

Exit Options:
Wallpaper - Sets the wallpaper condition on exit from the screen saver.    Last Screen Saver will set the 
last image used as the current wallpaper.    This is the slowest option, and will cause a delay between the 
time the mouse is moved or a key is pressed and the restoration of your working screen.    Restore Prev 
will leave the wallpaper as it was when the screen saver activated, and None will clear the screen 
completely.
WWPlus Wallpaper Timer - establishes the condition of the wallpaper timer in WWPlus when the screen 
saver terminates.    The options are On, Off, and Restore previous.
Mouse movement required to exit - Determines the amount of travel required to terminate the screen 
saver.    Movement is stored up, so a series of small moves will result in termination.    This storage is 
reset whenever the image changes.
Exit if image change has not occurred in x seconds - The WWPlus Screen Saver communicates with 
WWPlus via DDE.    During the DDE process, the screen saver will appear to hang and will not respond to
the mouse or keyboard.    If something should happen to the DDE connection, the screen saver will 
terminate after a specified wait period.    The default of 60 seconds should be adequate, but if you use 
large highly-compressed images that take longer than a minute to decode you will want to lengthen the 
time.    If WWPlus has not completed the image conversion within the specified time then the screen saver
will interpret it as a DDE failure.
Password Protect - You may establish a password that must be entered to end the screen saver.    This 
provides a minimal security for your computer when you are away from it.    The password you enter is 
recorded only for the WWPlus Screen Saver, and is not shared with other Windows screen savers.

For general screen saver information, see the WWPlus Screen Saver topic.



 
Position Wallpaper Button
Pressing this button, active only when an image is selected in the queue, is the same as choosing 
Position Wallpaper in the Wallpaper menu.    For more information, see the Adjusting wallpaper placement
on screen topic.



Queue Menu Button
Displays the queue menu.    See Changing Queues for general information on this menu.



Smart Captions
Smart captions are small black-on-yellow labels that give a text caption for an icon.    When you position 
your mouse pointer over various of the WWPlus screen elements a caption will pop up that describes the 
element.    Once you are familiar with the screen you may want to turn these captions off, which you can 
do in the preferences menu.



Change Password
Use this dialog box to set a password for the screen saver. 
Choose one of the following for more information about the dialog box. 

Old Password

New Password

Retype New Password



Old Password
Use this option to specify the old password.    This box is unavailable if you are specifying a password first
time.
Þ Type your old password in the box.



New Password
Þ Type your new password in the box.

Passwords can contain up to 20 characters, including punctuation, and are not case-sensitive.    An 
asterisk (*) appears in the box for each character you type.



Retype New Password
Use this option to confirm your password.

Þ Type your new password again in the box.



Photo Scanning Service
Arcata Pet now offers a photo scanning service.    Turn your own photographs into custom wallpaper and 
screen saver images.    We have the hardware and software to produce high resolution images from your 
prints or 35mm slides.    As an incentive to try the service, and a bonus for registering WWPlus, we will 
produce two scans for free, with no shipping charges.

There is an order form for scanning services in the file SCANNING.TXT which installed in your WWPlus 
directory 

To be fair for those who registered WWPlus before this offer was available, or who decide to try it later, 
this offer is extended to include prior registrants.    In that case, please include the shipping charges, and 
write "Already Registered" on the order form.



Drag and Drop
WWPlus supports Drag and Drop of files to the queue.    The program must be running when this is done. 
Select image files in the File Manager and drag them by holding the left mouse button down until you are 
over the WWPlus window, or the icon for the minimized program.    Release the mouse button, and the 
files will be added to the queue.    If you drop files that do not have extensions recognized by WWPlus 
those will be ignored without harm.



DDE: Controlling WWPlus from other applications
If you are familiar with DDE (Dynamic Data Exchange), you may write macros in other applications that 
control two WWPlus applications: the Timer, and Change Wallpaper.

The information needed is as follows:

Application: WWPLUS

Topic: Wallpaper

Item: Command

DDE Function: DDEExecute

Available commands:    TimerOff, TimerOn, Change




